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*************************************** 

Water on a Stone . . . 

by Curt B. Witcher 

*************************************** 

Most of us are at least passingly familiar with the concept of “water on a stone.” Though something 

may be literally, or figuratively, as hard as a rock, persistent drops of water trickling over the 

stone will eventually cause the stone to crack and break apart. And yes, it typically takes a long 

time.  

 

We know this is true in our research. Continually looking to discover every shred of information 

about a potential ancestor’s life--from where he lived and worked to the church where his family 

worshipped, and special activities and records of the ethnic group of which he was a part--can 

break nearly every one of our brick walls. It can take a lot of looking as well as significant time 

evaluating, but eventually we usually crack that stone.  

 

The concept of “water on a stone” can work in other ways in the genealogy space, other not-so-

positive ways. Often we become so focused on our own research that we don’t notice all of the small 

but extremely consequential events occurring around us that eventually will have dramatically 

negative effects on future generations being able to discover and tell their stories. Individuals 

from coast to coast perennially forget to secure their family keepsakes and records from natural 

disasters. Almost every time a house is lost to a fire, flood or tornado, a little personal library also 

is lost forever. It’s heart-breaking to watch families in Moore, Oklahoma, desperately search 

through mounds of rubble for family heirlooms, or flood victims in San Antonio, Texas, search 

through water, mud and destruction for pictures and family albums. There is such joy and 

excitement when an individual finds one military citation or a family Bible, and yet the unspoken 

reality is that most all of the precious, unique family documents are gone. If each of us continues to 

do nothing about safeguarding and sharing our family stories, it’s “water on the stone” of future 



generations’ ability to find relevant data. 

 

Schools all over the country are deciding to no longer allow their local libraries to acquire their 

yearbooks under the pretext of protecting their students’ identities and privacy. Certainly not one 

of us wants our young peoples’ lives put in danger, or their identities and privacy placed in peril. 

However, in the haste and zeal to appear to be doing something about an important issue, there are 

many unintended consequences whose effects are long lasting. It’s particularly disturbing when such 

decisions are not fact-based but rather, purely emotion-based. There is no personal, identifying 

information with a student’s name in a school yearbook that couldn’t otherwise more easily be 

obtained from other sources. But yet, it’s today’s yearbooks that will suffer extinction in local 

history collections. Ironically, just a few short years from now, those same school officials likely 

will be contacting their local libraries for their own personal research purposes, or to work on a 

celebratory account of the school, and be irritably surprised not to find the yearbooks and the slice 

of history they would have provided. More “water on the stone” of future generations’ ability to 

find relevant information.  

 

Coast to coast, legislative bodies are actively seeking to restrict access to vital records and other 

documents that are key to our ability to discover and tell our stories. Numerous states are 

proposing to close access to birth records for 125 years. At the same time, many are proposing that 

death records be closed for 75 years after an individual’s demise. One state’s change to the access 

to its death records would technically/legally only qualify the deceased to have access. Really?! All 

this is being done under the guise of protecting identities and privacy. Yet the overwhelming 

majority of identity theft activities are perpetrated without even a hint of these records being 

used. Most every citizen is so disenfranchised from these legal processes that he or she doesn’t 

even notice or know that these codes and regulations are being written into law. The many 

thousands of fraudulent tax returns based on false identifications and stolen social security 

numbers have nothing to do with everyday citizens accessing the records that document their 

history; they have to do with a federal government entity that engages in processes that are 

neither contemporary nor secure. It is yet more “water on the stone” of our grandchildren’s ability 

to find their stories.  

 

We see abandoned cemeteries year after year on our vacation treks and muse what a shame it is, 

but take no action, not even to preserve the cemeteries in our own hometowns. Where are the 

sextons’ records and the cemetery plat maps? Who is capturing the images of the tombstones 

eroding from acid rain and other environmental impacts? In courthouses across the country, 

dedicated, hard-working clerks and their staffs are trying to deal with generations, and sometimes 

centuries, of old, deteriorating records with precious few resources. The examples are nearly 

infinite. I challenge us to significantly increase our awareness of the hundreds upon hundreds of 

seemingly small and disconnected events that, like water on a stone, continuously erode our abilities 

to discover our families’ stories and pass them along to our descendants. 

 

Honoring Our Veterans . . . 

 

During this past Memorial Day weekend, The Genealogy Center posted two small collections of 

military information on our website as a modest way to honor our veterans. As with all the data we 

post, it is free for everyone to use.  



1. Fortville Grand Army of the Republic Post #228, Hancock County, Indiana. This Sol. D. Kempton 

post was in operation from 1883-1930. 

GenealogyCenter.Info/results_fortvillegar.php 

2. The GAR Section of Cedar Hill Cemetery, Newark, Licking County, Ohio 

GenealogyCenter.Info/military/civilwar/results_cedarhillgar.php 

If you have images of your military ancestors and data files documenting military service of family, 

friends and community, we would be pleased to host them on the “Our Military Heritage” site for 

others to access.  

 

Preserving, Sharing, Supporting . . . 

  

Did you notice the new button in the top left corner of the GenealogyCenter.org homepage, just 

under the navigation bar? Check it out! It’s a neat way to have unique heritage pieces specific to 

your family made just for you, and to support The Genealogy Center at the same time. Read more 

about this endeavor further on in this ezine.  

 

An Awesome Time in An All-America City . . . 

 

August 21st through 24th are going to be awesome days for family historians gathered in Fort 

Wayne, Indiana. The upcoming Federation of Genealogical Societies 2013 Conference is going to 

pack those days with opportunities to learn, network and engage with some of the best presenters 

and vendors in the genealogy space. You definitely will want to be a part of this gathering. Read 

more in an article in this ezine, and register today at www.FGSConference.org. It would be great to 

see you in person in just a few months!  

 

*************************************** 

Potawatomi Research 

by Sara Allen  

*************************************** 

The Genealogy Center has historical and genealogical materials about many of the First Nations 

peoples, including the Potawatomi, one of the indigenous tribes to inhabit the land that became 

Indiana. There are at least three bands of Indiana-related Potawatomi about whom we have records 

here at The Genealogy Center: the Pokagon, Citizen and Prairie Bands.  

 

For a general history of the Pokagon Band, see “The Pokagons, 1683-1983: Catholic Potawatomi 

Indians of the St. Joseph River Valley” (970.3 P85clc). This book details the fascinating history of 

a band that was not forcibly removed from this area as other natives were. Instead, Chief Leopold 

Pokagon negotiated an amendment to the Treaty of Chicago (1833) that allowed his St. Joseph 

River Valley Band to establish a home in southwest Michigan, in part because of the tribe’s 

conversion to Catholicism. A second copy of this book, with the alternate call number 970.3 C61po, 

is in the main collection and may be checked out. The Pokagon Band of Potawatomi 

(http://www.pokagon.com/), now centered in Dowagiac, Michigan, is federally recognized and will 

enroll as members those who can trace an ancestor to one of two censuses, Cadman’s Roll of 1895 

and the Shelby Roll of 1896. For an abstract of Cadman’s Roll, see Raymond Lantz’s “The Potawatomi 

Indians of Michigan, 1843-1904” (977 L29P).   

 



Other bands of Potawatomi from Indiana were forced westward by the U.S. government beginning 

in the 1830s, with stops along the way in Illinois, Missouri and Iowa, ending eventually in Kansas 

(Prairie Band) and Oklahoma (Citizen Band). Bands from Michigan, Wisconsin and Illinois also were 

forced west to these reservations during the mid-nineteenth century. The Citizen Band 

(http://www.potawatomi.org/) requires that a person have a lineal relative on the 1937 tribal census 

in order to qualify for membership (see Microtext, Indian Census, Roll 496). This census provides an 

English name (and infrequently an Indian name), sex, age, tribe, degree of blood, marital status, 

relationship to head of household, residence and annuity information for each person. Occasional 

handwritten marginal notes indicate further information, such as date of death. The Prairie Band 

(http://www.pbpindiantribe.com/) requires one-quarter Prairie Band Potawatomi blood to enroll in 

the tribe.  Our microtext holdings for this tribe include Indian censuses from 1891-1942 (Rolls 

393-395). These census records include each person’s enumeration number, name (Indian and 

English), relationship to head of household, age, and sex. For histories of these groups, see “The 

Prairie People: Continuity and Change in Potawatomi Indian Culture, 1665-1965” (970.3 P85cl) and 

“The Potawatomi People (Citizen Band)” (970.3 P85ca). If you are interested in First Nations 

peoples of Indiana, be sure to consult this group of records.  

 

*************************************** 

The New York Slave Conspiracy of 1741  

by John D. Beatty 

*************************************** 

One of the most significant events in the history of colonial New York City, all but forgotten until 

recently, was the alleged Slave Conspiracy of 1741. Between March and April of that year, a series 

of 13 fires destroyed a number of buildings in lower Manhattan, leading many to suspect that they 

were set intentionally in a conspiracy by slaves and poor whites against the city’s white leadership. 

Much of the city was already on edge from a conspiracy in South Carolina two years earlier and a 

previous slave conspiracy in New York in 1712. Fears were also heightened by the belief that Spain, 

at war with Britain at the time, had an interest in stirring up trouble in the city and destabilizing 

the colony.   

 

Mary Burton, a 16-year-old Irish born indentured servant, was arrested for receiving stolen goods 

and was coerced by a local judge, Daniel Horsmanden, to give testimony against others involved in 

the conspiracy. More fires, arrests and forced testimony followed in a climate of hysteria 

reminiscent of the Salem witchcraft trials. At its height during the summer, 152 blacks, nearly half 

of the city’s population of male slaves older than 16, were imprisoned, along with 20 whites. Some 

were burned at the stake, others hanged or gibbeted, and 72 were deported. 

 

Historians differ as to whether the events of 1741 constituted an actual conspiracy. The Genealogy 

Center has several books that address the event from these varied viewpoints. Peter Charles 

Hoffer, in his book, “The Great New York Conspiracy of 1741,” (Lawrence, Kans.: University Press of 

Kansas, 2003), GC 974.7 H675g, contends that there was a slave plot at the root of the fires, in 

spite of the obvious racism and hysteria that surrounded the arrests and trials. Some of those 

executed were clearly guilty, but many innocents also were accused and punished. A second copy of 

this volume is available in the main collection with the call number 974.71 H67g and can be checked 

out. 

 



Jill Lepore takes a differing view in her book, “New York Burning: Liberty, Slavery, and Conspiracy 

in Eighteenth-Century Manhattan” (New York: Alfred A. Knopf, 2005), GC 974.702 N422Lef. 

Exploring in detail the racially-explosive climate of the period and the likelihood of perjured 

testimony, Lepore concludes, “Whether enslaved men and women actually conspired ... is a question 

whose answer lies buried deep in the evidence, if it survives at all.” She places much of the blame 

for the events on Horsmanden and his abuse of witnesses. Significantly for genealogists, Lepore 

includes an extensive appendix listing all of the people accused, the dates of their arrest and trial, 

and their sentences. The last names of the slave owners also are included, along with their full 

names listed alphabetically in a second appendix. The library owns a second, circulating, copy of this 

book also, with the call number 974.71 L55n. 

 

Horsmanden's journal of the trial has been published in various editions, the most complete being 

the 1744 edition, available digitally. 

http://law2.umkc.edu/faculty/projects/ftrials/negroplot/journalplot.html. A recent edition, greatly 

abridged by Serena R. Zabin, was published in 2004: “The New York Conspiracy Trials of 1741: 

Daniel Horsmanden's Journal of Proceedings,” GC 974.702 N422nyco. 

 

As disturbing and lurid as the events of 1741 may seem to a modern audience, they open a window 

into early 18th-century Manhattan, and if you have ancestors there during this time period, the 

Hoffer and Lepore books are well worth reading. 

 

*************************************** 

Technology Tip of the Month--Adobe Photoshop/Elements: Using the Smart Blur Tool to Create 

Line Drawings 

by Kay Spears 

*************************************** 

Maybe sometime in your future, you will want to create a line drawing from one of your photographs. 

This article will describe one way to do that using the Smart Blur tool available in Adobe Photoshop 

and Elements. 

 

As always, some photographs work better than others. Photographs that have good contrast have 

been the ones that seemed to work best for me whenever I tried to manufacture a line drawing.    

 

To create a line drawing, first open your photograph, and then create a duplicate layer. Make sure 

that the duplicate layer is the active layer when you do this exercise. Next, go to the Filter tab and 

find Blur in the drop-down list. The Blur tool you want to choose is Smart Blur. When you click on 

Smart Blur, a dialog box will open that includes the Zoom Tool, Radius Slide Tool, Threshold Slide 

Tool, and drop-down menus for Quality and Mode. In the Quality drop-down menu, choose “High.” In 

the Mode drop-down menu, choose “Edge Only.” This will cause your duplicate layer to change so 

that the image is black with white lines – it might look kind of like a negative. Experiment with the 

slide bars of both the Radius and Threshold. You can achieve different amounts of lines using those 

tools. It’s up to you what amount you want for your finished work. When you are satisfied, click OK. 

Your photograph will now be black and white, but mostly black.   

 

Next, for Adobe Photoshop go to Image>Adjustments>Invert and invert the image. In Elements, 

Invert is located under Layer>New Adjustment Layer>Invert. In Elements, a dialog box appears for 

http://law2.umkc.edu/faculty/projects/ftrials/negroplot/journalplot.html


you to name the layer. After doing so, click OK. This creates another layer in your Layers Palette, 

which is the invert.  Merge this layer down and this is your inverted image. 

 

Now you have a line drawing and what you do with it is up to you. There are numerous effects that 

you can achieve by combining your line drawing with other tools available. Experiment with changing 

the opacity, adding color, changing the blending modes, experimenting with the filter gallery or 

adding a mask. Some of the results are very amazing! 

 

Next: Adobe Photoshop/Elements, a Look at Perspective. 

 

*************************************** 

Quick-Tip of the Month for Preservation--War of 1812 Preserve the Pensions Project 

by Dawne Slater-Putt, CG(sm)* 

*************************************** 

When we consider the word “preservation” as connected with genealogy and family history, possibly 

the first thing that comes to mind is the conservation of personal documents, photographs and 

heirlooms, and how to preserve those for future generations. But many of our local and state 

genealogical societies and other groups have cast a wider net and initiated projects to preserve 

large and small sets of documents for the future. 

 

One of these larger efforts is the War of 1812 Preserve the Pensions Project spearheaded by the 

Federation of Genealogical Societies (FGS). The War of 1812 pension and bounty land files are one 

of the most requested types of records among researchers at the National Archives and because of 

this heavy use, were suffering marked deterioration. FGS, in conjunction with the National 

Archives, Fold3 and Ancestry.com, is raising money for the digitization of the 7.2 million pages of 

documents within these files. 

 

The digitization of each page costs 45 cents. Ancestry.com has established a grant for the project, 

matching every dollar donated. So a donation of $45, which initially would pay to digitize 100 pages, 

will ensure the preservation of 200 pages of pension files with the matching Ancestry grant. The 

files are being uploaded to Fold3.com, where they will remain free for public viewing indefinitely. 

 

To date, about 590,000 pages of pension and bounty land files have been preserved, with just about 

32 percent of the total funds needed raised. The goal is to have the total amount raised by the end 

of the War of 1812 Bicentennial in 2015. If you are interested in helping with this important 

project, details about how to donate are at www.PreserveThePensions.org.   

 

*“CG” & “Certified Genealogist” are service marks of the Board for Certification of Genealogists, 

and are used by authorized associates following periodic, peer-reviewed competency evaluations. 

Certificate No. 386 awarded 4 July 1996; expires 4 July 2016. 

 

*************************************** 

Innovation!  Personalized Textile Products  

By Kathy Carrier of Keepsake Threads 

*************************************** 

In May, The Genealogy Center launched an initiative to offer personalized textile products to 

http://www.preservethepensions.org/


genealogy enthusiasts. Partnering with a Fort Wayne, Indiana, company, Keepsake Threads, The 

Center has developed an initial product line that includes pillows and wall art. Customers can order 

these items using the pink Keepsake Threads link in the top left-hand corner of The Genealogy 

Center’s website. The new product line is now “live” at: www.GenealogyCenter.org. 

 

Both the pillows and the wall art will be created using customers’ family trees or cherished family 

photos. The pillows are $40 and the wall art is $35. Larger, custom items that incorporate more 

complex family trees also can be ordered for an additional charge. In addition, if individuals have a 

particular color preference for the fabric and the look of the product, Keepsake Threads can 

customize the order with by color preference as well.  

 

The initiative was created with the genealogy enthusiast in mind and also to build the Allen County 

Public Library Foundation's Genealogy Endowment Fund. A percentage of the sales from this 

venture will be directed into the Foundation, which “was created in 1984 as a private, non-profit 

501(c)3 trust to receive, administer and distribute income exclusively for the charitable and 

educational purposes of the Allen County Public Library. The Foundation raises private dollars to 

enhance the library’s acquisitions, innovations and special projects beyond the capacity of the 

normal operating budget.” 

 

If you attend the Federation of Genealogical Societies Conference in Fort Wayne this August, you 

will be able to see samples of the product line at the Keepsake Threads booth. Stop by and see the 

pillows and wall art first-hand! 

 

The Keepsake Threads-Genealogy Center product line will grow as customers express an interest in 

other products. So, if you are interested in featuring your genealogy research on a quilt, a fabric 

animal, a scarf or a tie, simply email Keepsake Threads at familytree@keepsakethreads.com, or call 

877-99THREADS. 

 

We are anticipating a great response to this service and look forward to the opportunity to expand 

this product line and innovative initiative.   

 

*************************************** 

What's Beyond Ancestry's Leaves and Branches  

***************************************  

The next event in The Genealogy Center’s “Beyond Ancestry’s Leaves & Branches” series is a 

“WeRelate Overview,” 2-3 p.m. Monday, June 24, given by Genealogy Center librarian Cynthia 

Theusch. WeRelate.org is one of the largest genealogy wikis. Explore this free site and how it can 

help you post your family information on the Internet. Other upcoming sessions in the series are: 

“Genealogy Jargon,” 2-3 p.m. Wednesday, July 24, and “Public Member Trees on Ancestry.com,” 2-3 

p.m. Thursday, September 12. All of these sessions will be held in Meeting Room A. To learn more, 

see the brochure at 

www.GenealogyCenter.org/Libraries/2013_Brochures/BeyondAncestryWeb.sflb.ashx. To register 

for any of these presentations, email Genealogy@ACPL.Info or call 260-421-1225. Check to see 

What’s Beyond Ancestry's Leaves and Branches! 

 

*************************************** 



Family History Fundamentals 

***************************************  

“Hear ye, hear ye!” Newspapers chronicle the lives and times of our ancestors. Instructor Delia 

Bourne will show what may be found in newspapers, and explain how to find what is available online 

on Saturday, June 8, 2013, 10-11 a.m., in Meeting Room A. Future sessions in the “More Family 

History Fundamentals” series are: “Just Start ‘Looking’ on Ancestry.com” on Saturday, July 13, and 

“Jumping Off Points: Getting the Most Out of a Single Record,” on Saturday September 14. All 

sessions are 10-11 a.m. in Meeting Room A. To learn more, see the brochure at 

www.GenealogyCenter.org/Libraries/2013_Brochures/FundamentalsWeb.sflb.ashx. To register for 

any of these free classes, email Genealogy@ACPL.Info or call 260-421-1225. It's time to get back 

to fundamentals! 

 

*************************************** 

Federation of Genealogical Societies Conference Excitement! 

***************************************  

The Federation of Genealogical Societies’ annual conference, being held in Fort Wayne at the Grand 

Wayne Convention Center (GWCC) 21-24 August 2013, actually kicks off on August 20th with 

Librarians’ Day at the Allen County Public Library. That day there will be several sessions aimed at 

librarians who serve genealogists. Also offered on that Tuesday will be one-on-one consultations and 

a Q&A panel at the GWCC. The Q&A panel is open to the public; the consultations are for 

conference registrants. 

 

Four days of conference sessions follow, with Wednesday as Focus on Societies Day. The 

conference will feature experts in the field of genealogy presenting sessions for all levels of family 

historian, from the beginner to the expert. A large exhibit hall will feature books, technology and 

software, and will highlight societies. The week also will include workshops, daily luncheons 

sponsored by organizations, and evening social events. 

 

Learn more about this marvelous opportunity at the conference website at www.FGSConference.org. 

In addition, you can:  

view or subscribe to the FGS Conference Blog at  

http://www.fgsconferenceblog.org,  

“like” the conference on Facebook at  

http://www.facebook.com/FGSconference, 

and follow the conference on Twitter at  

http://www.twitter.com/FGSconference and hashtag #FGS2013. 

 

*************************************** 

Out and About 

***************************************  

Curt Witcher 

June 28, 2013 

American Library Association Genealogy Pre-Conference--Harold Washington Library Center, Multi-

Purpose Rooms A & B, 400 South State Street, Chicago, IL, 9:45 a.m. CDT. Presentation: “And the 

Rockets’ Red Glare: Sources for War of 1812 Research.” 

 



John Beatty 

June 7, 2013 

“Primetime39” live call-in program with host Bruce Haines, 7:30-8 p.m. Topic: Fort Wayne as a “City 

of Churches.” 

 

*************************************** 

Area Calendar of Events 

*************************************** 

Allen County Genealogical Society of Indiana (ACGSI) 

12 June 2013--Allen County Public Library, First Floor Meeting Rooms, Annual banquet, 6 p.m. 

Reservations are required. Featured speaker is Jana Sloan Broglin giving her presentation: 

“’Hookers, Crooks and Kooks’ Aunt Merle Didn’t Run a Boarding House.” 

 

Allen County-Fort Wayne Historical Society 

2 June 2013--History Center, 302 E. Berry Street, Fort Wayne, Indiana. 2 p.m. George R. Mather 

Sunday Lecture Series featuring Todd Maxwell Pelfrey on “Fort Wayne’s Park and Boulevard 

System: A Centennial Perspective.” 

 

*************************************** 

Driving Directions to the Library 

*************************************** 

Wondering how to get to the library?  Our location is 900 Library Plaza, Fort Wayne, Indiana, in the 

block bordered on the south by Washington Boulevard, the west by Ewing Street, the north by 

Wayne Street, and the east by the Library Plaza, formerly Webster Street.  We would enjoy having 

you visit the Genealogy Center. 

 

To get directions from your exact location to 900 Library Plaza, Fort Wayne, Indiana, visit this link 

at MapQuest: 

http://www.mapquest.com/maps/map.adp?formtype=address&addtohistory=&address=900%20Web

ster%20St&city=Fort%20Wayne&state=IN&zipcode=46802%2d3602&country=US&geodiff=1  

 

>From the South 

Exit Interstate 69 at exit 102.  Drive east on Jefferson Boulevard into downtown. Turn left on 

Ewing Street. The Library is one block north, at Ewing Street and Washington Boulevard. 

 

Using US 27: 

US 27 turns into Lafayette Street. Drive north into downtown. Turn left at Washington Boulevard 

and go five blocks. The Library will be on the right. 

 

>From the North 

Exit Interstate 69 at exit 112.  Drive south on Coldwater Road, which merges into Clinton Street.  

Continue south on Clinton to Washington Boulevard. Turn right on Washington and go three blocks. 

The Library will be on the right. 

 

>From the West 

Using US 30: 



Drive into town on US 30.  US 30 turns into Goshen Ave. which dead-ends at West State Blvd.  

Make an angled left turn onto West State Blvd.  Turn right on Wells Street.  Go south on Wells to 

Wayne Street.  Turn left on Wayne Street.  The Library will be in the second block on the right. 

 

Using US 24: 

After crossing under Interstate 69, follow the same directions as from the South. 

 

>From the East 

Follow US 30/then 930 into and through New Haven, under an overpass into downtown Fort Wayne.  

You will be on Washington Blvd. when you get into downtown.  Library Plaza will be on the right. 

 

*************************************** 

Parking at the Library 

*************************************** 

At the Library, underground parking can be accessed from Wayne Street. Other library parking 

lots are at Washington and Webster, and Wayne and Webster. Hourly parking is $1 per hour with a 

$7 maximum. ACPL library card holders may use their cards to validate the parking ticket at the 

west end of the Great Hall of the Library. Out of county residents may purchase a subscription 

card with proof of identification and residence. The current fee for an Individual Subscription Card 

is $70. 

 

Public lots are located at the corner of Ewing and Wayne Streets ($1 each for the first two half-

hours, $1 per hour after, with a $4 per day maximum) and the corner of Jefferson Boulevard and 

Harrison Street ($3 per day). 

 

Street (metered) parking on Ewing and Wayne Streets. On the street you plug the meters 8am – 

5pm, weekdays only.  It is free to park on the street after 5pm and on the weekends. 

 

Visitor center/Grand Wayne Center garage at Washington and Clinton Streets. This is the Hilton 

Hotel parking lot that also serves as a day parking garage.  For hourly parking, 7am – 11 pm, charges 

are .50 for the first 45 minutes, then $1.00 per hour.  There is a flat $2.00 fee between 5pm and 

11pm. 

 

*************************************** 

Genealogy Center Queries 

*************************************** 

The Genealogy Center hopes you find this newsletter interesting.  Thank you for subscribing.  We 

cannot, however, answer personal research emails written to the e-zine address.  The department 

houses a Research Center that makes photocopies and conducts research for a fee.   

 

If you have a general question about our collection, or are interested in the Research Center, please 

telephone the library and speak to a librarian who will be glad to answer your general questions or 

send you a research center form.  Our telephone number is 260-421-1225.  If you’d like to email a 

general information question about the department, please email: Genealogy@ACPL.Info. 

 

*************************************** 



Publishing Note:   

*************************************** 

This electronic newsletter is published by the Allen County Public Library's Genealogy Center, and 

is intended to enlighten readers about genealogical research methods as well as inform them about 

the vast resources of the Allen County Public Library.  We welcome the wide distribution of this 

newsletter and encourage readers to forward it to their friends and societies.  All precautions have 

been made to avoid errors.  However, the publisher does not assume any liability to any party for 

any loss or damage caused by errors or omissions, no matter the cause.   

 

To subscribe to “Genealogy Gems,” simply use your browser to go to the website:  

www.GenealogyCenter.org. Scroll to the bottom, click on E-zine, and fill out the form. You will be 

notified with a confirmation email. 

 

If you do not want to receive this e-zine, please follow the link at the very bottom of the issue of 

Genealogy Gems you just received or send an email to kspears@acpl.lib.in.us with "unsubscribe e-

zine" in the subject line.  

 

Dawne Slater-Putt, CG & Curt Witcher, co-editors 


